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About this Manual

What This Manual Covers

This manual contains information and instructions on:

System requirements

Installing Protege GX

Server security configuration

Initial site configuration and license activation
Performing system backups

It also includes a checklist to help you make sure that the software is set up correctly (see next page).

Who Should Read This Manual

This manual is intended for those that will be installing and configuring Protege GX.

For instructions on using and programming Protege GX, refer to the Protege GX Setup Guide and Protege GX
Operator Manual (About | Help in the software).

What You Should Already Know

This manual assumes that you have an intermediate working knowledge of the Microsoft Windows operating
system. Details of basic Windows functionality are beyond the scope of this document.

For support, please contact ICT technical support by email or telephone. Refer to the ICT website (www.ict.co) for
additional details.
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Installation Checklist

This checklist contains the basic requirements for completing a Protege GX installation. You can print this page for
easy reference as you work through the installation manual.

Some installations may have additional requirements not listed here.
Before You Begin

[] Acquire a software serial number (SSN) from ICT

] Confirm that the intended server machine meets the minimum hardware and operating system
requirements (see next page)

Prerequisite Software
[1 Install Microsoft .NET (see page 10)
[] Install Microsoft SQL Server (see page 10)

Installation

[1 Install the Protege GX server (see page 11)

Security Configuration

[1 Configure TLS 1.2: Enable force encryption, TCP/IP and IS Management Console (see page 13)
1 Disable insecure protocols using IIS Crypto (see page 17)

[1 Enable Transparent Data Encryption (see page 18)

[1 Enable Mandatory ASLR (see page 20)

1 Allow services through Windows Firewall (see page 20)

Initial Site Setup
1 Activate the Protege GX license (see page 22)

[ Add asite (see page 23)
(1 Add a controller using the controller wizard (see page 23)

Backing Up the System

[1 Enable scheduled programming backups (see page 25)

1 Enable scheduled event purging and differential backups (see page 25)
[1 (Optional) Set the recovery model (see page 26)

[1 Back up the TDE certificate (see page 29)

Additional Software Installation
[1 Install Protege GX clients (see page 12)

[] (Optional) Install the Protege GX SOAP Service (see the Protege GX SOAP Service Installation Manual)
1 (Optional) Install the Protege GX Web Client (see the Protege GX Web Client Installation Manual)

Once the software has been installed, you can bring your hardware online and program the Protege GX system.
For the next steps, see the Protege GX Setup Guide.
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Before You Begin

This section covers system requirements, prerequisites for installation and other important information. Please
take a moment to read the material in this section before installation.

System Requirements

Computer Hardware Requirements

When you set up a new Protege GX system, you must ensure that the server and client computers have sufficient
computing resources to run the system.

The minimum computer specifications for new Protege GX systems are:

Server: 1-29

Server: 30+

Component Controllers Controllers Client Recommendations
64-bit 64-bit 64-bit
CPU 4 cores 6 cores 4 cores For new sites, select a CPU model that is no more
8 threads 12 threads 8 threads than 5 years old at time of commissioning.
3.3GHz 2.5GHz 3.3GHz
RAM 16GB 3268 16GB !nstall additional RAM whenever possible to
improve performance.
Disk 500GB 500GB 100GB Use an SSD, as this will give better performance
than an HDD.
Ethernet 100Mb/1Gb 100Mb/1Gb 100Mb/1Gb Use Cat5e or Cat6 ethernet cables for optimal

transmission speeds.

If you have an existing system with lower server specifications, you are not required to upgrade the server.
However, if the system experiences performance issues we strongly recommend that you upgrade your server to

match the specifications above.

These requirements cover the base Protege GX installation only. Extended services have separate hardware
requirements, which are outlined in the relevant documentation.

Computer Name

The name of the Protege GX server must be 15 characters or less. The software will not function correctly if the

computer's name is longer than 15 characters.

Supported Screen Resolutions

The Protege GX user interface supports the following standard screen resolutions:

« 1280 x1024
« 1400 x 1050
« 1600 x1200
« 1680 x 1050
« 1920 x 1080

Selecting alternative screen resolutions may produce unexpected display results.
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Third-Party Integrations

Third-party systems such as video management systems have their own minimum system requirements. If you are
planning to install both systems on a single server, ensure that the server has sufficient resources to run both
software packages.

Supported Operating Systems

Microsoft Windows Server 2025 Standard, Datacenter 64-bit
Microsoft Windows Server 2022 Standard, Datacenter 64-bit
Microsoft Windows Server 2019 Standard, Datacenter 64-bit
Microsoft Windows Server 2016 Standard, Datacenter 64-bit
Microsoft Windows 11 Pro, Business, Enterprise 64-bit
Microsoft Windows 10 Professional, Enterprise 64-bit

Virtual Server Environments

The Protege GX server is supported on virtual server environments. However, ICT reserves the right to request
customer replication of any errors in a non-virtual environment.

When installing in virtual server environments, ensure that the system requirements (see previous page) are met
by the virtualized hardware. Review the resources and performance of the VM carefully before completing the
installation.

SQL Server Compatible Versions

The Protege GX application uses a non-proprietary open SQL database engine to store and share information. The
software is compatible with SQL 2016, 2017, 2019 and 2022 in Standard, Express, and Enterprise editions.

The Express edition is a scaled down, free edition of SQL Server that includes the core database engine and
functionality. The Express version of SQL supports a database size of up to 10 GB.

To obtain either SQL or SQL Express, download the appropriate installer from the Microsoft website. It is also
recommended to download SQL Server Management Studio from Microsoft in order to configure SQL. Download
the latest general availability (GA) version of SSMS from the Microsoft website.

Database Installation on Remote SQL Server

The Protege GX platform supports remote SQL Server installations. In these installations, ensure that the
connection between the database server and the Protege GX server has enough bandwidth for peak usage. This is
vital to the correct operation of the system.

When Protege GX has been installed on a remote SQL Server environment, ICT Technical Support reserves the
right to request customer replication of any errors in a local SQL Server environment.

Prerequisites

The following third-party components must be installed prior to installing Protege GX. Installation instructions are
included below (see page 10).

The latest version of Microsoft NET Framework 4.

At the time of writing, the latest available version is Microsoft .NET Framework 4.8.1
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Microsoft SQL Server (required on server machine only): The software is compatible with SQL 2016, 2017, 2019
and 2022 in Standard, Express, and Enterprise editions.

Note that Microsoft SQL Server has its own set of prerequisites, which are specific to the version of Microsoft
SQL Server being installed. You must also ensure that the SQL Server version is compatible with the Windows
version that it will be installed on. Please refer to the Microsoft website for the prerequisites, associated files
and installation instructions for your particular version.

Permissions

Installation Permissions

To install the Protege GX server or client, you must have local administrator permissions on the computer where
you are performing the installation. You do not need domain administrator permissions.

Operators who use the Protege GX client do not need administrator permissions.

Service Permissions

By default, the Protege GX services use the local system account (NT AUTHORITY\SYSTEM) on the server
computer. This account has permission to perform most actions by default.

To harden the Protege GX server against attack, you can create a dedicated service account with restricted
permissions. This ensures that the Protege GX services only have the permissions they need to function. See
Application Note 365: Restricting Protege GX Service Permissions for a full list of permissions and instructions for
setting up the service account.

SQL Server Permissions

The Protege GX services require the following permissions to the ProtegeGX and ProtegeGXEvents databases:
CONNECT
EXEC

db_datareader
db_datawriter

Licensing

During installation you will need to enter your software serial number (SSN), so ensure you have this on hand.

Protege GX has a modular licensing structure with a range of extensions and optional features. You can purchase
additional licenses before or after the software installation. For more information about the features provided with
the base license and available extras, see the PRT-GX-SRVR Datasheet.
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Installation

Protege GX uses a client/server architecture. Every installation includes a server which holds the main system
database and the Protege GX services. In most cases it will also have the client software installed. The client
application can then be installed on additional workstations, enabling multiple operators to access the system.
These workstations connect to the database and services on the Protege GX server.

You must have local administrative privileges on the server and workstation(s) you are performing the installation
on.

Installing the Prerequisites

Before Protege GX can be installed the prerequisite software must be installed.

Microsoft .NET Framework
Microsoft SQL Server

Installing the Microsoft .NET Framework

Each workstation running Protege GX client software requires the latest version of Microsoft .NET Framework 4.

At the time of writing, the latest available version is Microsoft .NET Framework 4.8.1

To Install the Microsoft .NET Framework

1. Download the latest NET Framework 4 installer from the Microsoft website.

2. Runthe .NET Framework installer file. This launches the Microsoft .NET Framework Setup.
3. Read and accept the License Agreement, then click Install.

4. Follow the onscreen instructions to complete installation.

It is recommended that the machine is rebooted once the .NET installation has completed. Although a reboot is
not essential, additional components may be necessary to complete the installation, such as the Windows Image
Control installation.

Installing Microsoft SQL Server

There are several editions of SQL Server (users can use either SQL Server or SQL Server Express), ranging from a
database only installation to database, advanced services, and manageability tools installation.

Advanced settings within SQL Server or customizing the SQL installation to a particular environment are beyond
the scope of this document. If you have specific enquiries, please contact your system administrator or the ICT
support team.

It is recommended that you do not change the SQL Server default settings unless specified below, as these are
required for Protege GX to run correctly.

To Install Microsoft SQL Server:

1. Download the setup file for the required version of SQL Server from the Microsoft website. The installation
steps may differ slightly depending on which version you have selected.
2. The SQL Server setup file requires internet access to download the supporting files.
If the server does have internet access:
Run the SQL Server setup file on the server.
Select the Custom installation type.
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Set the installation location and click Install to download and run the setup files.
If the server does not have internet access:

Run the SQL Server setup file on another computer with internet access.

Select Download Media.

Set the download location and click Download.

Transfer the files to the server via USB.

Run the installer on the server.

3. Inthe SQL Server Installation Center, click New SQL Server stand-alone installation or add features to an
existing installation.

4. The installer will run checks on the system to ensure that you have the necessary prerequisites and there are
no potential problems during setup. Resolve any issues that are raised and click Next.

5. Set the Installation Type to Perform a new installation of SQL Server. Click Next.
6. Accept the license terms and click Next.

7. On the Features page, select the following and click Next:
Database Engine Services
SQL Server Replication

8. Set the Named instance and Instance ID to PROTEGEGX. Click Next to continue.
9. Click Next at each stage to accept the default settings.

10. The installation will progress until SQL Server setup is complete. Click Close to exit the setup wizard.

Installing the Protege GX Server

Before installing Protege GX, the database engine (Microsoft SQL Server) must be installed separately.

You do not need to install SQL Server on client workstations (computers that will connect remotely to the Protege
GX server). To complete client installations, refer to the Protege GX Client Installation section (see next page).

Installing the Protege GX Server Components:

1. Run the supplied setup.exe file. This launches the Protege GX install wizard. Click Next to continue.
2. Read and accept the license agreement, then click Next.

3. Enter your registration information, including your name, company, and product serial number. Click Next to
continue.

4. Click Next to install to the default folder, or click Change to choose another location.

5. Choose the Setup Type, then click Next.
Complete: To install all program features
Custom: To choose the program features and where they will be installed. Use this option if you don't
want to install the client interface on the server. Click the icon next to a feature to disable it. Click Next to
continue.

6. Choose whether to enable or disable Start the services automatically to complete the installation.
By default, the services will use the local system account when they start. This account has permission to
perform most actions on the server. To use the local system account, enable Start the services
automatically to complete the installation.
To use a different account, disable Start the services automatically to complete the installation. This
allows you to change the account used by the services after installation, then start them manually. Use this
method if you are performing a remote installation, or if you will run the services under a restricted
account.

For more information, see Permissions (page 9).
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Click Next.

Enter the details of the database server where the Protege GX database will be created. If you selected the
defaults when installing SQL Server, this will be the server name and Protege GX (where Protege GX is the SQL
instance). Click Next to continue.

To customize the database names and/or paths, clear the setting to Hide advanced database configuration
options and enter the relevant details. It is recommended that these settings only be modified by advanced
users. Click Next to continue.
The next screen shows the authentication and communication settings for the data service and client.

To accept the default TLS 1.2 authentication method and TCP ports, do not make any changes.

If operators will be able to log in with Windows Authentication using Active Directory, select Enable
Windows Authentication. If you need to enable this feature later, you must uninstall the software and
then reinstall with this option selected.

If the default TCP/IP ports are not available on the network, change the ports as required.
Click Next.

Click Install to begin installation.

Click Finish to complete the installation and exit the install wizard.

Installing the Protege GX Client on Remote Workstations

The Protege GX client is automatically installed as part of the server installation and does not need to be installed if
the server components have already been installed on the machine. The following steps need to be performed on
additional operator workstations.

Installing the Protege GX Client Application:

1.
2.
3.

Run the supplied setup.exe file. This launches the Protege GX install wizard. Click Next to continue.
Read and accept the license agreement, then click Next.

Enter your registration information, including your name, company, and product serial number. Click Next to
continue.

Click Next to install to the default folder, or click Change to choose another location.

Choose the Custom setup type and click Next. This enables you to select the program features that will be
installed.

Click the Server option and select This feature will not be available. The server component is removed from
the list of features to be installed.

The next screen shows the authentication and communication settings for the data service and client. The
settings used in the client must match those in the server (see above). Edit the settings if required, then click
Next.

Click Install to begin installation.

Click Finish to complete the installation and exit the Install Wizard.
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Recommended Security Settings

Itis strongly recommended that Protege GX server installations use best-practice security settings to reduce the
risk that the server is exposed to attack.

See the Permissions section for information and recommendations about service permissions.

Configuring Protege GX to use TLS 1.2

TLS (Transport Layer Security) is a set of security protocols which are implemented to protect commmunications
and transferred data. TLS 1.2 is the default security setting for communication between Protege GX software
components.

TLS 1.2 Setup

TLS 1.2 is the default security option in the Protege GX installation process, and required items are automatically
set up in the background unless a different option is selected. If TLS 1.2 is not currently enabled in your installation,
you can enable it by reinstalling the application and ensuring that TLS 1.2 is selected.

To check whether TLS 1.2 was enabled during installation, navigate to the installation directory (C:\Program Files
(x86)\Integrated Control Technology\Protege GX) and open GXSV.exe.config in a text editor. If the file contains
the text ss1Protocols="T1s12" then TLS 1.2 was enabled.

As part of the Protege GX install process a number of items are installed or configured. These include:
Installing Microsoft NET Framework 4.6.2.
Installing OLE DB Driver 18.
Creating a self-signed certificate on the local PC.

Adding configuration entries into the Windows Registry.
Adding required configuration entries into the Protege GX config files.

In addition to the above the following manual steps are required to fully enable TLS 1.2 for Protege GX.

Different configuration is required to use TLS 1.2 with Windows Authentication. For instructions see Application
Note 277: Configuring Protege GX to use TLS 1.2.

Enabling Force Encryption and TCP/IP

1. Open SQL Server Configuration Manager:
Press Windows + R to open the run dialogue.

Type sqlservermanager<version>.msc, replacing <version> with the version number of the application
corresponding to your SQL Server installation (see this page).

ok T

2. Open the SQL Server Network Configuration section from the left-hand pane.

3. Right click on Protocols for ProtegeGX (or the SQL instance name that holds the Protege GX database), and
select Properties.

4. Inthe Properties window set Force Encryption to Yes and click OK.

5. Open Protocols for Protege GX.

6. Double click TCP/IP and set Enabled to Yes. Click OK to close the window.

7. Open SQL Server Services from the left-hand pane.

8. Right click on SQL Server (ProtegeGX) in the right-hand pane and select Restart to restart the Protege GX
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SQL Server Service.

9. When complete, close the SQL Server Configuration Manager.

Enabling the IIS Management Console

1. Enable the IIS Management Console by navigating to: Control Panel > Programs and Feature > Turn
Windows Features On or Off.

2. Inthe feature list, navigate to Internet Information Services > Web Management Tools > IIS Management
Console. Check the box to enable this feature.

3. Click OK.

4. Restart all Protege GX services.

Using a Custom Certificate

In some systems, it is preferred to use a custom TLS/SSL certificate instead of the self-signed certificate generated
by Protege GX during installation. Some additional configuration is needed to install the custom certificate.

This is required when there are Protege GX clients connecting to the server from outside the router/firewall and
port forwarding is in place. The custom certificate must refer to the external hostname of the Protege GX server.

The exact process may vary depending on your operating system. Consult your IT provider for more detailed
instructions.

Obtaining the Server Certificate

An SSL certificate in the form of a .pfx file must be obtained from your IT provider. This can be self-signed or
provided by a trusted certificate authority. You will also require the password used to generate the file, in order to
install the certificate.

Installing the Server Certificate

1. Copy the .pfx file to the Protege GX server you are installing the certificate on.
Double click the certificate to initiate the Certificate Import Wizard.

. Set the Store Location to Local Machine.

Enter the password used to generate the .pfx file. The person who generated the certificate should know this.

2

3

4. Do not change the File to Import.

5

6. Set the place where you wish to store the certificate as the Personal folder.
7

Complete the import.

Configure Protege GX to use the Certificate

Once the certificate is installed you will need to configure Protege GX to use that certificate for its connections.

1. Open Microsoft Management Console by pressing [WIN + r], typing mmc and pressing enter.

Once the console is open, open Add or Remove Snap-ins by pressing [CTRL + m], or via the File menu.
Double click Certificates, select Computer Account and click Next.

Select Local Computer and click Finish.

Click OK to close the snap-ins window.

Navigate to Certificates (Local Computer) > Personal > Certificates.

You should be able to see your installed certificate here. Double click on it.

o N O A NN

Find the field named Thumbprint and copy the data from it to a safe place.
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9. Open GXSV.exe.config, located in the installation directory (C:\Program Files (x86)\Integrated Control
Technology\Protege GX).

Files in this directory require administrator permissions to edit. You may need to open the file as an
administrator using an application like Notepad++, or make a copy in a different directory to edit and replace
the original.

10. Locate the following section in the XML:
/configuration/system.serviceModel/behaviors/serviceBehaviors/behavior[@name="md"]/serviceCertificate

If this section does not exist it is because you did not install Protege GX with TLS enabled.

1. Inthe <serviceCertificate> tag, change the findValue to the thumbprint of the new certificate you
installed. The result will look similar to the following:

<serviceCertificate
storeLocation="LocalMachine" storeName="My" findValue="CERTIFICATE
THUMBPRINT" x509FindType="FindByThumbprint" />

12. Save the config file and restart the Protege GX Data Service for the changes to take effect.

Custom Wildcard Certificates

It is possible to install custom wildcard TLS certificates in the same way as the standard custom certificates above.
In addition, you must change the hostname in GXPl.exe.config and GXRpt.exe.config from localhost to the full
hostname.

This should be completed for both config files for each client installation. The easiest method is to update the
files on one client machine, then copy them to other machines as necessary.

The following sections need to be updated in each file:

configuration/system.serviceModel/client/endpoint@address: This should be the full
hostname that you are actually connecting to.

configuration/system.serviceModel/client/endpoint/identity/dns@value: This should
be the first entry listed in the certificate's Subject Alternative Names section.

When using a wildcard certificate, when an operator opens the client they must leave the Server field blank. If this
field is filled, the client will fail to connect correctly.

Example:

<endpoint
address="net.tcp://servername.domainname:8000/GXSV/GXService"
behaviorConfiguration="md0"
binding="netTcpBinding"
bindingConfiguration="Bindingl"
contract="ServiceReference2.IGXService">
<identity>

<dns value="*.domainname" />

</identity>

</endpoint>

<endpoint
address="net.tcp://servername.domainname:8010/GXSV/GXService2"
behaviorConfiguration="md0"
binding="netTcpBinding"
bindingConfiguration="Bindingl"
contract="GXServiceRef2.IGXService2">
<identity>
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<dns value="*.domainname" />
</identity>
</endpoint>

Enabling Certificate Validation on the Client

When a custom trusted certificate is in use, it is recommended to enable service certificate validation to harden

the connection between the Protege GX server and client. This protects against man-in-the-middle attacks during
the initial connection.

This is only available when a third-party certificate provided by a trusted authority is used, or a self-signed
certificate that has been installed as a trusted certificate on client workstations. If the same client workstation is

used to connect to multiple Protege GX servers, this setting requires all servers with TLS enabled to use a trusted
certificate.

To enable service certificate validation, complete the following configuration on all client workstations:

1. Open GXPl.exe.config, located in the installation directory (C:\Program Files (x86)\Integrated Control
Technology\Protege GX).

Files in this directory require administrator permissions to edit. You may need to open the file as an

administrator using an application like Notepad++, or make a copy in a different directory to edit and replace
the original.

2. Directly after the <configSections> node, add the <appSettings> node as shown below:

<configSections>
<section
name="microsoft.scripting"
type="Microsoft.Scripting.Hosting.Configuration.Section,
Microsoft.Scripting, Version=1.0.0.0, Culture=neutral, PublicKeyToken=null"
requirePermission="false" />
</configSections>
<appSettings>

<add key="client.validateServiceCertificate" value="true" />
</appSettings>

3. Locate the following <behavior> node:

<behavior name="md0">

<dataContractSerializer maxItemsInObjectGraph="2000000000" />
<clientCredentials><serviceCertificate><authentication
certificateValidationMode="Custom" customCertificateValidatorType
="CAVLib.CertAuth.RedirectableStorevValidator, CAVLib, Version=1.0.0.0,
Culture=neutral, PublicKeyToken=null"
/></serviceCertificate></clientCredentials>
</behavior>

4. Remove the entire <clientCredentials> node, if present. The new <behavior> node should be as
follows:

<behavior name="md0">

<dataContractSerializer maxItemsInObjectGraph="2000000000" />
</behavior>

5. Save the config file.

The customized config file may be overwritten when the software is upgraded. You may be required to repeat
these changes after upgrading the Protege GX client software.
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Configuring the Protege GX SOAP Service

This section describes the additional configuration required to deploy the Protege GX SOAP Service for TLS 1.2.

1. When installing the Protege GX SOAP Service, ensure that you install with TLS enabled.
On the Customize WCF TCP/IP Port page, point the SOAP service to the Protege GX server:
Protege GX Data Server installed PC name: the DNS name or hostname of the Protege GX server
Data Server Port: 8000 (or as configured)
Report Server Port: 8010 (or as configured)

For instructions on installing the SOAP Service, see the Protege GX SOAP Service Installation Manual.

2. Locate and edit the following file: C:\inetpub\wwwrootProtegeGXSOAPService\Web.config.

Under /configuration/system.serviceModel/, comment out or remove this line:

<serviceHostingEnvironment multipleSiteBindingsEnabled="true" />.

When using TLS security (recommended) on the data service:
Under /configuration/system.serviceModel/client/endpoint@address, setthe
endpoint hostname to the DNS name or hostname of the Protege GX server.
Under
/configuration/system.serviceModel/client/endpoint/identity/dns@value,
set the endpoint DNS-identity to one of the 'Subject Alternative Names' in the data service's TLS
Certificate.
The following node should not exist when using a custom certificate. Remove if present:
/configuration/system.serviceModel/behaviors/endpointBehaviors/behavio
r[@name=md@]/clientCredentials/serviceCertificate/authentication.

Renewing TLS Certificates

Sometimes it is necessary to renew or update the TLS certificate associated with a Protege GX installation. This
can happen when:

The existing certificate expires.
The server's IP address or hostname changes so that the existing certificate is no longer valid.

If you are using the default self-signed certificate generated by your Protege GX installation, you must uninstall
and reinstall Protege GX to generate a new self-signed certificate.

If you are replacing a custom certificate, you will need to install and configure the new certificate as described
above (see page 14). To complete the process, restart the Protege GX Data Service.

Disabling Insecure Cipher Suites and Protocols

We recommend that you follow best practice by disabling old and insecure cipher suites and communication
protocols on the Protege GX server and SOAP server. This requires editing the registry settings on the computer
where the Protege GX server is installed, as well as the computer hosting the SOAP service if this is installed
separately. For more information about the relevant settings, see the Microsoft documentation and contact your IT
provider.

Always back up (export) the registry settings before editing the registry.

IIS Crypto by Nartac Software is a useful tool for managing security settings. It allows you to apply security

settings to the server without needing to manually edit the registry.

A standard Protege GX installation has been validated with the PCI 3.2 and Best Practices settings from IIS Crypto
3.2. PCl 3.2 provides stricter security and is the recommended setting.

To apply these settings:
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1. Download lISCrypto.exe from the link above.

2. Runthe program and click Yes to allow it to make changes to your computer.
3. Navigate to the Templates tab.

4. Select the PCl 2.2 template from the dropdown, then click Apply.

5

Restart the computer to implement the new settings.

Protege GX supports a wide range of integrations, which may not all be compatible with best-practice security
settings. In addition, older hardware may not support more recent encryption protocols. In some situations, it may
be necessary for you to enable less secure cipher suites and communication protocols. It is the responsibility of
the installer to ensure that appropriate security settings are applied.

Enabling Transparent Data Encryption

Transparent Data Encryption (TDE) is an SQL Server feature which allows you to encrypt the Protege GX
databases "at rest”. The data is encrypted on the disk, then decrypted when it is accessed by an application such
as the Protege GX software. This prevents the data from being read if an attacker gains access to the databases or
backups; for example, if the physical storage medium is stolen.

We recommend that you implement TDE on both the programming database and the events database.

This feature is supported on the following SQL Server Editions:

SQL Server Enterprise (2008 onwards)
SQL Server Standard (2019 onwards)

For more information about TDE, see Transparent Data Encryption (TDE) in the Microsoft Help. If your SQL Server

version does not support TDE we recommend that you investigate other methods of encrypting the databases at
rest.

It is critical that you back up the certificate used to encrypt the databases. Because database backups are
also encrypted, you will need the certificate to restore a database backup to a new server. If the certificate has
not been backed up it is possible to lose all of the data in the database backups.

If you are supplying a database backup to ICT Technical Support for replication of an issue, you will also need
to supply the certificate.

TDE may have a small impact on server performance (3-5%). This mostly affects the CPU.

The decrypted data can be accessed by anyone with access to the SQL instance. Use restrictive access
controls to prevent unauthorized access.

Enabling Transparent Data Encryption

1. Open Services as an administrator:
Press the Windows + R keys.
Type services.msc into the search bar.
Press Control + Shift + Enter.

2. Locate the Protege GX Update Service. Right click on the service and click Stop. This will also stop the other
Protege GX services.

3. Open SQL Server Management Studio (SSMS) and connect to the Protege GX instance as an admin user.
4. Click New Query.

5. Enter the query provided below. This will cause SQL Server to do the following:
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1. Create a Database Master Key protected by a password.

2. Create a certificate protected by the master key.
3. Create one Database Encryption Key per database, protected by the certificate.
4. Enable encryption on each database.
USE master;
GO
CREATE MASTER KEY ENCRYPTION BY PASSWORD = '<UseStrongPasswordHere>';
GO
CREATE CERTIFICATE TDECertificate WITH SUBJECT = 'TDE Certificate';
GO
USE ProtegeGX;
GO

CREATE DATABASE ENCRYPTION KEY
WITH ALGORITHM = AES 256
ENCRYPTION BY SERVER CERTIFICATE TDECertificate;
GO
ALTER DATABASE ProtegeGX
SET ENCRYPTION ONj;
GO
USE ProtegeGXEvents;
GO
CREATE DATABASE ENCRYPTION KEY
WITH ALGORITHM = AES 256
ENCRYPTION BY SERVER CERTIFICATE TDECertificate;
GO
ALTER DATABASE ProtegeGXEvents
SET ENCRYPTION ONj;
GO

Ensure that you customize the following parameters:

Encryption PASSWORD: Enter a strong password for the Database Master Key and save this in a secure
location.
TDE Certificate SUBJECT: Enter an appropriate name for the certificate. This will also be used for the
SERVER CERTIFICATE parameters.
If you are not using the default names for the ProtegeGX and ProtegeGXEvents databases, update the
names.

6. Click Execute. The SQL server will work in the background to encrypt the databases.

7. You can view the encryption progress using the Database Encryption Keys dynamic management view.
Execute the following query:

SELECT *
FROM sys.dm database encryption keys;

8. Once encryption is complete you must back up the encryption certificate and private key using the following
query:

BACKUP CERTIFICATE TDECertificate TO FILE = 'c:\storedcerts\TDE
Certificate'
WITH PRIVATE KEY ( FILE = 'c:\storedkeys\TDE Key' ,
ENCRYPTION BY PASSWORD = '<UseAnotherStrongPasswordHere>"' );
GO

SQL Server will export the certificate and private key files to the specified locations.
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9. Store the certificate and private key backups in a secure location and record the password used to encrypt the
private key.

If the certificate, private key or password are lost it will not be possible to restore database backups to

another server.

10. Take a full backup of both databases using the instructions in System Backups.

11. Start the Protege GX services by starting the Protege GX Data Service, then the Protege GX Download Service.

Enabling Mandatory ASLR

Address space layout randomization (ASLR) is a memory-protection process which randomizes the location
where system executables are loaded into memory. This helps to guard against buffer-overflow attacks by making
it more difficult for an attacker to predict target addresses and exploit memory corruption vulnerabilities.

The Mandatory ASLR option available in Windows Security can be used to ensure that all EXEs and DLLs on the
operating system are forcibly randomized at runtime. For more information about Mandatory ASLR see the
Microsoft documentation or contact your IT provider.

To maintain legacy compatibility this feature is disabled by default on all Windows operating systems. We
recommend that you follow best practice by enabling Mandatory ASLR on your Protege GX server, SOAP server,
and for maximum security all Protege GX client workstations.

You will require administrator permissions to enable this feature.
To enable Mandatory ASLR:

1. Open Windows Security.
Navigate to App and browser control.

Under the Exploit protection section, select Exploit protection settings.
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Under System Settings, go to the Force randomization for images (Mandatory ASLR) option and change the
setting to On by default.

5. Restart the computer to implement the new settings.

Allowing Services through Windows Firewall

It may be necessary to allow some Protege GX services through the Windows firewall to prevent inbound
communication being blocked. Outbound connections are typically enabled by default.

1. Open the Windows firewall settings at Control Panel > Windows Defender Firewall.

2. Click the Allow an app or feature through Windows Defender Firewall link on the left of the screen.

Third-party antivirus or firewall software may prevent modification of Windows Firewall rules. If this is the
case, refer to the third-party manufacturer for details on allowing programs through the firewall.
3. Select Allow another app... to add a program as an exception.

4. Click Browse..., then navigate to the Protege GX installation directory.

The default installation directory is C:\Program Files (x86)\Integrated Control Technology\Protege GX.

5. Select (double click or select and Open) the executable that you want to allow, then click Add.
Add the following Protege GX executables:
GXSV.exe
GXEvtSvr.exe
This allows these services to receive inbound connections through the Windows firewall.
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The above process will only allow access through your primary network connection. If you have multiple networks
connected you will need to manually allow access (tick the checkbox in the network column) for each additional
network that the Protege GX executable requires access through.
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Initial Protege GX Site Configuration

After installing Protege GX, the software must be configured to communicate with the controller.

For detailed instructions on programming a controller, see the Protege GX Integrated System Controller
Configuration Guide, available from the ICT website.

Log In to Protege GX

1. Double-click the Protege GX icon on your desktop, or browse to the program from your Windows Start Menu:
Start > All Programs > ICT > Protege GX > Protege GX
The Logon window is displayed.
2. Loginas auser with full access to the system. For new installations, log in using the default administrator
operator username of admin with a blank password.

3. If connecting to a Protege server on a different machine, enter the server details or IP address.
4. Click Logon.

It is highly recommended that you change the admin operator's password to a very secure password after first
logon. To do this, click the Change password button at the bottom of the home page.

Password Requirements

When creating or changing the admin operator password it is highly recommended that you create a very secure
password.

As a guideline, a secure password should include these features:

Minimum 8 characters in length
Combination of upper and lower case letters
Combination of numbers and letters
Inclusion of special characters

Passwords must comply with password policy requirements.

Activating Your License

Before you can use Protege GX you must register your software license with ICT. You must also repeat this
process to update your license file whenever you add new items or features to the license.

To register or update your Protege GX license you will need the following:

A device with internet access. There are two licensing methods available, depending on the network's internet
connectivity:
If the Protege GX server or any Protege GX client has internet access you can use Automatic licensing.

If no Protege GX machine has internet access you must use Manual licensing. You will need to use the
Protege GX server and another device which can access the internet.

The operator who activates or updates the license must have access to all sites in the system.
The Windows account used must have local administrative privileges.
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Activating Your License Automatically

1. Loginto Protege GX on any machine with internet access.
From the main menu, navigate to About | License.
Select the License update tab.

Click Download license.

oA N

Enter the required information and select OK.
The Protege application passes your details to the ICT web registration service, then activates your software
automatically.

6. Close and restart the Protege GX software to implement the new license.

Activating Your License Manually

1. Loginto Protege GX on the server machine.
From the main menu, navigate to About | License.

Select the License update tab.
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Click Generate to create a license request file. When prompted, save the ICT_LicenceRequest.req file to a
folder on the network or a portable drive.

Note down the link displayed beside "Download your license via the website".
Transfer the license request file to a device with internet access.

Open a web browser and browse to the link you noted above.
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Enter the required information and upload the license request file, then click Submit.

Your details are then passed to the ICT web registration service. Once registration is complete you will be
prompted to download your license (lic) file.

9. Transfer the license file to the Protege GX server.

10. Inthe License update tab, click Browse... and select the license file.

—

1. Close and restart the Protege GX software to implement the new license.

Adding a Site

1. When your first log in, you will be prompted to add a site.

2. Enter a name for your New site and click OK.

Adding a Controller

Once a site has been added, the Add controller window will appear.

You must add a controller at this stage to complete the setup of the Protege GX system. Do not close Protege

GX until you have completed this process.

1. Enter a Name for the controller and set the Count field to 1to add a single controller. Select the Type of
controller you wish to add.

2. Keypad and expander records can then be added from the relevant sections.

Hardware does not need to be connected before records are created.

3. Inthe Options section, select Create installer menu group and Create floor plan if required.

4. Set the default CID report map type. Large is recommended for most sites.
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5. Inthe Doors section, specify how many door records are to be created. The following options can also be
enabled or disabled:

Assign to reader expanders

Assign door trouble inputs

Assign reader lock output to door configuration
Assign reader beeper to door alarm configuration

6. Once complete, click Add Now.

7. Navigate to Sites | Controllers. The settings set below should match those in the controller's web interface.
Serial number: The serial number of the controller.

IP address: The system controller has a built in TCP/IP ethernet device and must be programmed with a
valid TCP/IP Address to allow the software to connect. By default the IP address is set to 192.168.1.2.

Download port: The TCP/IP port used to send downloads to the controller. By default this is port 21000.
Download server: From the drop-down menu, select the download server to be used by the controller.
Control and status request port: The TCP/IP port used to send control commands to the controller. By
default this is port 21001

8. Click Save.

You may need to restart the services to bring the controller online. Select the Services option from the Control
Panel and restart the Protege GX services.
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System Backups

It is recommended that all Protege GX systems back up both Protege GX databases regularly. The instructions in
this section outline how to set up regular backups in Protege GX and restore them in SQL Server Management
Studio (SSMS).

If you are upgrading an installation it is vital that you perform a system backup before completing the upgrade.
Failure to do so may cause permanent loss of data.

Backing Up the Programming Database

The ProtegeGX database contains all of the programming and configuration for the system. To set up regular
backups of the ProtegeGX database:

1. Navigate to Global | Global settings.

Enable Backup main database every night.

Enable Append day of week to backup file name to allow you to retain a week of backups.
Enter a Backup path that the server has access to. The folder must already exist.

Click Backup now.

Click Save.
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In the File Explorer, navigate to the backup location and check that the backup file has been created.

The backup file name will include the Protege GX version number and the day of the week it was created.

Backing Up the Events Database

The ProtegeGXEvents database contains all of the events generated by the system. It can fill up quickly, especially
on large or busy sites. Therefore, it is recommended to set up regular purging and differential backups of the
ProtegeGXEvents database. This prevents the database from becoming full while enabling you to restore past
events when required.

For more information about purging, backing up and restoring events, see Application Note 279: Purging and
Restoring the Protege GX Events Database.

1. Navigate to Global | Global settings.
2. Enter an Events DB backup path that the server has access to.

3. Click Backup now.

This full database backup will be required for restoring differential backups in future. Ensure that it is stored
securely and is not overwritten.

4. If the Protege GX system has been in operation for more than a year without purging the events database, it is
recommended to purge it manually. See Application Note 279: Purging and Restoring the Protege GX Events
Database

5. Set Purge events older than to the number of months or years that events will be retained before being
purged. This depends on the size of the site.

6. Enable Generate differential events backup.
7. Click Save.
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Backup Storage

We recommend that you use an offsite storage facility or external provider to ensure that copies of database
backups are located in a secure offsite location. Do not allow disk space to become too low on the Protege GX
server, as this can cause slow performance and other issues.

If you are using differential backups for the events database, ensure that the original full database backup is not

deleted or overwritten as this will make it impossible to restore differential backups later.

Setting the Recovery Model

In some versions of SQL Server, the recovery model is set to Full by default. This means that every change to the
programming and event databases is logged in the transaction log, allowing you to recover the databases to any
point in time in case of a failure. However, saving such a large number of transactions can impact the performance
of the system and quickly fill up disk space on the server.

If the server experiences performance issues, you may wish to change the recovery model to Simple for one or
both databases. With this recovery model the server does not log all changes, so databases can only be restored
to the last full or differential backup.

For more information about SQL Server recovery models, see the Microsoft Help.

If you wish to change the recovery model:

1. Open SQL Server Management Studio (SSMS) on the Protege GX server.
Connect to localhost/ProtegeGX.

Expand the Databases node.

Right click on the ProtegeGX database and select Properties.

Open the Options tab.

Set the Recovery model to Simple.

Click OK.

Repeat for the ProtegeGXEvents database.
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Database Compatibility

When you back up or restore a database, you should take note of the database version. The software version
number (see About | Version) indicates the database version as indicated below:

4 3 264 39

Database Version

Backups made by the Protege GX software always include the database version number in the filename. This is a
good practice to follow when making your own backups.
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When restoring a database, you must ensure that the database version of the backup file is compatible with that of
the software, as outlined below:

265 > 264 ©
264 = 264 (V)
264 < 265 o

If the database version is newer than the software version it is not possible to restore the database. Upgrade
the software before restoring.

If the version numbers match the restore should be successful.

If the database version is older than the software version the database can be restored but must be upgraded
to match the software version. Restore the database, then uninstall and reinstall the server software to
upgrade the database version.

Do not use the Repair option in the installer to upgrade the database, as the data service will fail to start.
Always uninstall and reinstall Protege GX.

If the database version and software version do not match, the data service will not start.

Restoring Database Backups

This section demonstrates how to restore programming backups using SQL Server Management Studio (SSMS).

These instructions assume you are using the Simple database recovery model to restore a full backup. To restore
to a specific point in time with the Full recovery model, see the Microsoft Help.

Before you restore a database, back up your current database so you can return to a known point if there are any
issues.

1. If you are restoring a database with Transparent Data Encryption to a different server, you first need to load
the encryption certificate onto the new server.

See Backing up and Restoring with Transparent Data Encryption for instructions.

2. Check the database version you are restoring against the current version of the software (About | Version).
If the database version is higher than the third number of the software version, do not proceed (see previous
page).

3. Open Services as an administrator:

Press the Windows + R keys.
Type services.msc into the search bar.
Press Control + Shift + Enter.

4. Locate the Protege GX Update Service. Right click on the service and click Stop. This will also stop the other
Protege GX services.

5. Open SSMS and connect to the Protege GX instance.

6. Expand the Databases node. Right click the ProtegeGX or ProtegeGXEvents database and select Tasks >
Restore > Database....

7. Set the Source to Device, then click the ellipsis [...] button.
8. Click Add to browse to the backup file (.bak) that you will restore. Click OK.
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9. The Restore Plan section will show the backup set(s) that are available to restore. If there is more than one,
use the backup date to determine which one should be restored, then check the Restore checkbox beside the
selected backup set.

10. Inthe Options tab, enable Overwrite the existing database.
11. Click OK to start the restore process.

12. If the database version you restored is earlier than the current version of the software, you must uninstall and
reinstall Protege GX to upgrade the database.

13. In the Services snap-in, right click on the Protege GX data service and click Start. If the data service starts, the
database restoration was successful.

Starting the data service also starts the event service and update service; however, the download service
must be started manually. It is recommended that you check the configuration before starting the download
service, as this will begin downloading programming to the controllers.

Restoring Differential Backups

To view purged events, differential backups can be restored through the SQL Server Management Studio. This
operation will restore the events database to a past state, recovering older events but removing current ones, so it
is important to take a backup of the current events database before restoring a differential backup.

These instructions assume you are using the Simple database recovery model to restore a differential backup. To
restore to a specific point in time with the Full recovery model, see the Microsoft Help.

Warning: Events that occur while the differential backup is being reviewed may be lost when the most recent

backup is restored. To reduce potential issues, restore the differential backup at a time when few events are
expected to occur or use a separate training server for the review.

1. Take a full backup of the events database:
In Protege GX, navigate to Global | Global settings.
In the Events database backup section, set the Events DB backup path then click Backup now.

For larger databases it may be quicker to force a differential backup. Simply set the Purge start time to one
minute in the future and allow the backup to occur. Remember to correct the setting afterwards.

2. Open Services as an administrator:
Press the Windows + R keys.
Type services.msc into the search bar.
Press Control + Shift + Enter.

3. Locate the Protege GX Update Service, right click and select Stop. This automatically stops all of the services.
4. Open SQL Server Management Studio and connect to the Protege GX instance.
5. Right click the events database and select Tasks > Restore > Database.

Leave the Source as its default option, Database.

6. Click on the Timeline button to open the Backup Timeline window.

Select the Specific date and time option.

Set the Timeline Interval to Week.

Scroll back through the weeks to view the differential backup dates and times.

Use the slider below the timeline to select the day you want to restore, then click OK to close the window.
7. Inthe Options tab, enable the Close existing connections to destination database option.

Do not change any other options from the defaults.
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8. Click OK to restore the events database to the date of the differential backup.
9. Restart the Protege GX services.

Once this backup is complete the Protege GX software will display events that occurred before the day of the
backup (up to the Purge events older than limit), but not any that occurred afterwards. To return the events to
the present time, repeat these steps to restore the backup that you created at the beginning of this process.

Backing up and Restoring with Transparent Data Encryption

When a database has Transparent Data Encryption (TDE) enabled, any backups from that database are also
encrypted. If you need to restore the database to another server you must first create a Database Master Key
(DMK) and add the backed up certificate to the new server.

Before you begin, you will need the certificate, private key and the password used to encrypt the private key. If
you do not have backups of these you can export them from the original server.

1. Onthe original server, click New Query and enter the following query:

BACKUP CERTIFICATE TDECertificate TO FILE = 'c:\storedcerts\TDE
Certificate'
WITH PRIVATE KEY ( FILE = 'c:\storedkeys\TDE Key' ,
ENCRYPTION BY PASSWORD = '<UseAStrongPasswordHere>'" );
GO

2. Click Execute. SQL Server will export the certificate and private key files to the specified locations.

You must back up the certificate, private key and the password used to encrypt the private key in a secure

location. If these are lost, it will not be possible to restore database backups to another server.

3. Transfer the files to the new server.

You will then need to create a Database Master Key and certificate on the new server.

1. Open SQL Server Management Studio (SSMS) and connect to the Protege GX instance as an admin user.
2. Click New Query.
3. Enter the following query:

USE master;
GO
CREATE MASTER KEY ENCRYPTION BY PASSWORD = '<UseStrongPasswordHere>';

GO

CREATE CERTIFICATE TDECertificate
FROM FILE = 'c:\storedcerts\TDE Certificate.cer'
WITH PRIVATE KEY (FILE = 'c:\storedkeys\TDE Key.pvk',
DECRYPTION BY PASSWORD = '<EnterPrivateKeyPasswordHere>");

GO
4. Click Execute. The certificate will be uploaded to the server and encrypted using the Database Master Key.

5. Restore the database backups as normal, following the instructions in Restoring Database Backups.

Backing up and Restoring with Encrypted Columns

Some features in Protege GX use encrypted database columns to keep your data secure:

PIN encryption
ICT wireless locking
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We recommend that you back up the Data Service Encryption Certificate to ensure that it is not lost if the Protege
GX server goes down. In addition, when you restore the Protege GX database to another server or secondary
download server you must import the certificate to allow the new server to access the encrypted columns.

Backing up the Certificate

The certificate is created on the machine where the data service is installed, which may not be the same machine
as the SQL server installation.

1. To open the Certificate Manager tool as an administrator, press the Windows + R keys, then type certim.msc
into the search bar and press Control + Shift + Enter.

2. Under Certificates - Local Computer, open Personal, then Certificates.

3. Inthe window displaying the certificates, scroll across to the Friendly Name column and locate the certificate
called Data Service Encryption Certificate.

4. Right click the certificate and select All Tasks > Export.
5. The Certificate Export Wizard will open. Click Next.

6. Select Yes, export the private key, then click Next.

The private key is the critical component in decryption. If you do not export the private key, when the
certificate is imported it will not be able to decrypt the encrypted data.

7. Select the following Export File Format options:
Include all certificates in the certification path if possible
Enable certificate privacy

The Delete the private key if the export is successful option must be disabled.
Then click Next.
8. On the Security page, select Password. Enter and confirm a strong password.
Save this password to a password manager or other secure location.
9. Set Encryption to AES256-SHA256, then click Next.
10. Specify an export File name and path, then click Next.
11. Click Finish to complete the certificate export.

When the export is complete, confirm that the certificate backup .pfx file has been exported to the file path as
specified. The file should be stored securely in a separate location to ensure that it is available if required.

You must back up the certificate and the password used to encrypt the private key in a secure location. If these

are lost, it will not be possible to restore database backups to another server.

Restoring the Certificate

1. Ensure that the .pfx backup file is accessible from the local PC.

2. Stop all Protege GX services before initiating the import.

W

To open the Certificate Manager tool as an administrator, press the Windows + R keys, then type certim.msc
into the search bar and press Control + Shift + Enter.

The tool directory will display Certificates - Local Computer.
Open the Personal folder.

Right click the Certificates sub-folder and navigate to All Tasks, then select Import.
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The Certificate Import Wizard will open. Click Next.
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8. Click Browse... and locate the .pfx backup file to import, then click Next.

You will need to change the file type dropdown to Personal Information Exchange (*.pfx;*.p12).

9. Enter the Password that was created during the export process.

10. Import Options:
Mark this key as exportable. This will allow you to back up or transport your keys at a later time.

This option must be selected if you want to be able to export/backup the private key with this
certificate in the future. This option is slightly less secure.

The key is more secure if this option is not selected, however you will not be able to export the private
key with the certificate in the future if you lose your current .pfx backup file.

Ensure that Include all extended properties is selected.
11. Click Next.
12. Ensure the Certificate store is set to Personal, then click Next.
13. Click Finish to complete the certificate import.
14. Close the Certificate Manager tool.
15. Restore the Protege GX database in SQL Server as normal.

16. Restart the Protege GX services.

Events Database ID Maintenance

The events database has a maximum Event ID of 2147483647 (around 2.1 billion), which may be reached on very
large and busy sites (200+ controllers) or those that have been running Protege GX for along time. This is not
affected by purging the events database.

As a preventative measure, we recommend turning off event logging for all or most inputs and outputs. This will
prevent logging of unnecessary events, such as motion detection when areas are disarmed, but will not affect
alarms and other functions.

Disable Log to event buffer in Programming | Inputs | Options.
Disable Log output events in Programming | Outputs | Options.

We also recommend archiving and replacing the events database before it reaches this limit. You can view the
Event ID column in the All Events report or a status page (if this has been hidden, right click on any column header
and select Show column chooser to retrieve it). When you observe new Event IDs exceeding one billion (ten digit

numbers), contact ICT Technical Support for assistance with backing up the events database and creating a new
one.

If the Event ID exceeds 2.1 billion, it will be unable to save new events. If this occurs:

1. Immediately open the Windows Services Manager and locate the Protege GX Event Service.
2. Right click and select Properties. Set the Startup type to Disabled.

3. Click Apply.
4

Click Stop. While the event service is stopped, controllers will save incoming events to prevent them from
being lost (up to 50,000 events per controller).

5. Contact ICT Technical Support as soon as possible for assistance with backing up your events database and
creating a new one.
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Disclaimer and Warranty

Disclaimer: Whilst every effort has been made to ensure accuracy in the representation of this product, neither
Integrated Control Technology Ltd nor its employees shall be liable under any circumstances to any party in
respect of decisions or actions they may make as a result of using this information. In accordance with the ICT
policy of enhanced development, design and specifications are subject to change without notice.

For warranty information, see our Standard Product Warranty.
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https://www.ict.co/Standard-Product-Warranty
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